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SCOPE

Understanding the platform. Determinism and concurrency; Handling input and output securely;
safe error handling and logging; Engineering fro security features; software security in
operations.

OBJECTIVES

e Grasp the fundamentals of a programming language and know the basic differences between
programming languages

.NET using WPF is a latest technology followed in the IT field.

Choose the architecture based on the problem to be solved.

Differentiate between the types of applications supported by .Net

Build, compile and execute a VB .Net program

Apply techniques to develop error-free software

UNIT I

Introduction to .NET: .NET framework features & architecture, CLR, common Type system,
MSIL, Assemblies and class libraries. Introduction to visual studio, Project basics, types of
project in .Net, IDE of VB .Net — Menu bar, Tool bar, Solution Explorer, Toolbox, Properties
Window, Form Designer, Output Window, Object browser. The environment:Editor tab, format
tab, general tab, docking tab. Visual development & event driven programming — Methods and
events.

UNIT I

The VB .Net Language: The VB .Net Language — Variabls- decalring variables, Data type of
variables, forcing variables declarations, scope & lifetime of a variable, constants, arrays, types
of arrays, control array, Structure programming — Modularity — Information hiding — abstraction
— events — subroutines and functions — message box — input box. Control flow statement:
conditional statement, loop statement.

Department CS, CA, & IT 1/2



UNIT I

Working with WPF: Introduction:Understanding Windows Graphics — WPF: A Higher Level
API — The architecture of WPF. XAML:Basics, properties and events in XAML — loading and
compiling — Layout. Classic controls: The Control class — content controls — text controls — list
controls — Range based controls.

UNIT IV

Objects and Collections: Understanding objects, properties, methods. Understanding collections.
Files: Introduction — classification of files — processing files — handling files and folder using
class — directory class — file class.

UNIT V

Database programming with ADO .Net: overview of ADO, from ADO to ADO .Net, accessing
data using server explorer. Creating connection, command, data adapter and data set with
OLEDB and SQLDB. Display data on data bound controls, display data on a data grid. Generate
reports using CrystalReportViewer.

Suggested Readings

1. Shrishchavan (2007). Visual Basic .Net (1st ed.). New Delhi: Pearson education.

2. Bryan Newsome (2012). Beginning Visual Basic. John Wiley & Sons, Inc.

3. Matthew MacDonald Pro (2008). Windows Presentation Foundtion with .Net 3.5
Apress

4. Duncan Mackenzie and Kent Sharkey (2006). Sams Teach Yourself Visual Basic .Net
(1st ed.). New Delhi: Techmedia.

5. lan Griffiths, Chris Shells (2005). Programming Windows Presentation Foundation
(1st ed.). O’Reilly Publishers

6. Jeffrey R.Shapiro (2002). The Complete Reference Visual Basic .Net. New Delhi:
Tata McGraw Hill Ed.

Websites
1. www.startvbdotnet.com
2. www.functionx.com
3. www.dotnetspider.com
4. www.developerfusion.com
5. http://www.wdftutorial.net/HelloWPF.html
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LECTURE PLAN
STAFF NAME: Mr. K. VEERASAMY
S.No Lecture Topics Support
Duration Materials
(Hr)
UNIT-I
1. 1 Introduction to .NET: .NET framework features & S1:1-4,S1:27-
architecture 30
2. 1 CLR, common Type system, MSIL, S1:31-37,
Assemblies and class libraries. W1
3. 1 Introduction to visual studio, Project basics S1:6-10
Types of project in .Net W1
4, 1 IDE of VB .Net, Menu bar S1:19-22
S1:10-23,
Tool bar, Solution Explorer W1
5. 1 Toolbox, Properties Window S1:14-18
6. 1 Form Designer, Output Window, and Object browser. S1:36-51
7. 1 The environment: Editor tab, format tab, S1:24-31
general tab, docking tab
8. 1 Visual development & event driven programming S1:19-30
S1:76-83, W2
Methods and events. S2:187-189,
9. 1 Recapitulation and discussion of important questions
Total No of Hours Planned For Unit - | 9
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LECTURE PLAN | 2016-2019

Batch
UNIT-1I
1. 1 The VB .Net Language: The VB .Net Language S1:99-101
Variables - declaring variables S111-116
2. 1 S1:104-105
Data type of variables, forcing variables declarations, S1:44-48 W1
scope & lifetime of a variable S3:86-90
3. 1 Constants, S1:130-131
Arrays, types of arrays, control array W2
4. 1 Structure programming — Modularity S1:204 T:77
5. 1 Information hiding — abstraction S1:292-298
6. 1 Events — subroutines and functions S1:204 T2:77
7. 1 S1:142-146,
Message box — input box 156-158
8. 1 Control flow statement: conditional statement. S1:125-129
Loop statement. S1:90-103,W4
9. 1 Recapitulation and discussion of important questions
Total No of Hours Planned For Unit— I 9
UNIT-I1I
1. 1 Working with WPF: Introduction: Understanding S3:1-3, W2
2. 1 Windows Graphics — WPF: A Higher Level API S3:4-21 W2
The architecture of WPF
3. 1 XAML.: Basics S3:23-29, W2
4, 1 Properties and events in XAML S§3:32-36, W2
5. 1 Loading and compiling — Layout S3:49-58, W2
6. 1 Classic controls: The Control class S3:183-193
7. 1 Content controls, Text controls S4:139-141
8. 1 List controls, Range based controls. S3:215-217
9. 1 Recapitulation and discussion of important questions
Total No of Hours Planned For Unit— 111 9
UNIT-IV
1. 1 Obijects and Collections: Understanding objects S1:334-335
2. 1 Properties, Methods S1:338-345
3. 1 Understanding collections S1:335T2:483
4. 1 Files: Introduction S1:399-400
5. 1 Classification of files S1:400-402
6. 1 Processing files S1:402
7. 1 | Handling files and folder using class S1:400-408
8. 1 S1:410-415,
Directory class, File class 428-235
9. Recapitulation and discussion of important questions
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LECTURE PLAN | 2016-2019

Batch
| Total No of Hours Planned For Unit— IV | 9
UNIT-V
1. 1 S2:293-
299,320-322
Database programming with ADO .Net: overview of ADO S2:515-516
2. | 1 | from ADO to ADO .Net, Accessing data using server explorer | S2:320-325
3. 1 | Creating connection, command and Data adapter S2:320-335
4. 1 | Data set with OLEDB S2:325-330
5. 1 | Data set with SQLDB $2:325-330
6. 1 | Display data on data bound controls S2:363-373
7. 1 | Display data on a data grid S2:363-373
8. 1 | Generate reports using Crystal Report Viewer. S2:363-373
9. 1 | Recapitulation and discussion of important questions
10.| 1 | Discussion of previous ESE Question papers
11. Discussion of previous ESE Question papers
1
12. Discussion of previous ESE Question papers
1
Total No. of Hours Planned For Unit—V 12
Total No. of Hours Planned: 60

Suggested Readings:

PwwnNeE

6.

Websites:

vk wnN e

Shrishchavan (2007). Visual Basic .Net (1st ed.). New Delhi: Pearson education.

Bryan Newsome (2012). Beginning Visual Basic. John Wiley & Sons, Inc.

Matthew MacDonald Pro (2008). Windows Presentation Foundation with .Net 3.5 Apress
Duncan Mackenzie and Kent Sharkey (2006). Sams Teach Yourself Visual Basic .Net (1** Ed.).
New Delhi: Techmedia.

lan Griffiths, Chris Shells (2005). Programming Windows Presentation Foundation (1** Ed.).
O’Reilly Publishers

Jeffrey R. Shapiro (2002). The Complete Reference Visual Basic .Net. New Delhi: Tata McGraw
Hill Ed.

www.startvbdotnet.com
www.functionx.com
www.dotnetspider.com
www.developerfusion.com
http://www.wdftutorial.net/HelloWPF.html
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UNIT - |

Introduction to .NET: .NET framework features & architecture, CLR, common Type system,
MSIL, Assemblies and class libraries. Introduction to visual studio, Project basics, types of
project in .Net, IDE of VB .Net — Menu bar, Tool bar, Solution Explorer, Toolbox, Properties
Window, Form Designer, Output Window, Object browser. The environment: Editor tab, format
tab, general tab, docking tab. Visual development & event driven programming — Methods and
events.

Introduction to .NET

As every living object in the world needs a language to communicate with each other.
Similarly the computer needs a language to communicate with the human beings. So
to communicate with the computer, we need a language as just like different languages
are spoken all over the world, there are different languages to communicate with the
computer. Such languages are known as Computer Languages. Compute Languages
can be broadly divided into three types namely high level languages, Assembly level
languages and Low level languages as shown in the figure.

Computer Languages

High Level Assembly Low level
Languages Language Language

Fig Programming Languages

High level languages are so powerful which are widely used by the humans to
communicate with the computer. They are called as high level languages since they
are easier to learn and use. So many computer languages come under this category.
Examples of such languages are BASIC, FORTRAN, COBOL, Pascal, C, C++, ALGOL,
PL/1, Ada, Visual Basic, Visual C++, and Visual Basic. Net and so on. In these
languages, we use English like words as instructions to communicate with the
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computer. People used a language called Assembly Language to communicate with the
computers before the introduction of high level languages.

In Assembly language, the instructions would be in the form of Mnemonic
Codes or Symbolic Codes. These codes are nothing but the instructions in the form of
abbreviations. For example the assembly language uses the abbreviated codes like
ADD, SUB or MULT and so on for to Add, Subtract or Multiply. Because of the
complexity, the assembly language is not widely used when compared to that of high
level languages. Computers can only understand binary values such as 1 and 0. With
the help of translators, the high level language code will be converted into machine
language. Before the translators were introduced, only machine lee language is used
for the communication.

.Net framework is a platform or an environment in which the user creates applications
using any one of the programming language that supported by .Net. It is a platform
neutral framework. The .NET Framework is a collection of services and classes. It is a
layer between the operating system and the programming language. It supports many
programming languages, including VB.NET, C# etc. NET provides a common set of
class libraries, which can be accessed from any .NET based programming language.
There will not be separate set of classes and libraries for each language. If you know
any one .NET language, you can write code in any .NET language. It is a major
technology change. Just like the computer world moved from DOS to Windows, now
they are moving to .NET. .NET technology was introduced by Microsoft, to catch the
market from the SUN's Java. Few years back, Microsoft had only VC++ and VB to
compete with Java, but Java was catching the market very fast. With the world
depending more and more on the Internet/Web and java related tools becoming the
best choice for the web applications. Thousands of programmers moved to java from
VC++ and VB. This was alarming for Microsoft and many of the Microsoft fans.

In order to tackle this Microsoft planned a project called Generation Windows
Services (NGWS)., under the direct supervision of Mr. Bill Gates. The outcome of the
project is what we now know as .NET. Even though .NET has borrowed most of its
ideas from Sun's J2EE, it has really outperformed their competitors.

Microsoft's VC++ was a powerful tool. But it was too complex. It has too many data
types, and developers had to learn many libraries including Windows SDK, MFC,
ATL, COM etc. There were many data type compatibility issues while exchanging data
between different layers. Visual Basic was too easy, and many serious programmers
hated it just for that reason. Even though Visual basic was very easy to use, it was not
very flexible to develop serious applications. Sun’s Java became a very good choice for
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these reasons. It had the flexibility and power of C++ and at the same time easy enough
to catch the attention of VB programmers.

Microsoft recognized these factors and they introduced the .NET considering all these
factors. All unwanted complexities are eliminated and a pure object oriented
programming model was introduced. This makes programmer's life very easy. .NET
framework comes with a single class library. And that’s all programmers need to
learn!! Whether they write the code in C# or VB.NET or J#, it doesn't matter you just
use the .NET class library. There is no classes specific to any language. There is nothing
more you can do in a language, which you can't do in any other .NET language. You
can write code in C# or VB.NET with the same number of lines of code, same
performance and same efficiency, because everyone uses same .NET class library. We
cannot define .NET as a 'single thing'. It is a new, easy, and extensive programming
platform. It is not a programming language, but it supports several programming
languages. By default .NET comes with few programming languages including C# (C
Sharp), VB.NET, J# and managed C++. .NET is a common platform for all the
supported languages. It gives a common class library, which can be called from any of
the supported languages. So, developers need not learn many libraries when they
switch to a different language. Only the syntax is different for each language.

History and Version of .NET Framework

Generation = Version Year Development tool Distributed with
number
1. 1.0 2002 Visual Studio .NET N/A
1.1 2003 Visual Studio .NET Windows Server
2003 2003
2. 2.0 2005 Visual Studio 2005 Windows Server
2003 R2
3.0 2006 Expression Blend Windows Vista,
3. Windows Server 2008
35 2007 Visual Studio 2008 Windows 7, Windows
Server 2008 RW2
4. 4.0 2010 Visual Studio 2010 N/A
45 2012 Visual Studio 2012 Windows 8, Windows
Server 2012
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Features of .NET Framework.
i) Net Framework 2.0 Features

a).ADO.NET: New features in ADO.NET include support for user-defined types
(UDT), asynchronous database operations, XML data types, large value types,

snapshot isolation, and new attributes that allow applications to support multiple
active result sets (MARS) with SQL Server 2005.

b).ASP.NET: The Microsoft .NET Framework 2.0 includes significant enhancements to
all areas of ASP.NET. For Web page development, new controls make it easier to add
commonly used functionality to dynamic Web pages. New data controls make it
possible to display and edit data on an ASP.NET Web page without writing code. An
improved code-behind model makes developing ASP.NET pages easier and more
robust. Caching features provide several new ways to cache pages, including the
ability to build cache dependency on tables in a SQL Server database.

c). NET Remoting: NET Framework Remoting now supports IPv6 addresses and the
exchange of generic types. The classes in the System.Runtime.Remoting.Channels.Tcp
namespace support authentication and encryption using the Security Support Provider
Interface (SSPI). Classes in the new System.Runtime.Remoting.Channels.Ipc
namespace allow applications on the same computer to communicate quickly without
using the network.

d).XML: The new System.Xml. XmlReaderSettings class allows specification of the type
of verifications to be done when using a subclass of XmlReader to read XML data.

ii) .Net Framework 3.0/3.5 Features

a).Windows Presentation Foundation (WPF): Windows Presentation Foundation
(WPF) is a next-generation presentation system for building Windows client
applications. The core of WPF is a resolution-independent and vector-based rendering
engine that is built to take advantage of modern graphics hardware.
WPF extends the core with a comprehensive set of application-development features
that include Extensible Application Markup Language (XAML), controls, data binding,
layout, 2-D and 3-Dgraphics, animation, styles, templates, documents, media, text, and
typography. WPF is included in the Microsoft .NET Framework, so you can build
applications that incorporate other elements of the .NET Framework class library.
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b).Windows Communication Foundation (WCF): Windows Communication
Foundation (WCF) is Microsoft's unified programming model for building service-
oriented applications. WCF allows you to build many kinds of distributed applications
including "traditional" Web Services so that your services support SOAP and will
therefore be compatible with older .NET (and other) technologies.

c).Windows Workflow Foundation (WWF): Windows Workflow Foundation, a core
component of .NET Framework 3.0, provides a programming model, run-time engine,
and tools for building workflow applications.
Workflows can be authored in code, XAML markup, or a combination of both, known
as code-separation, which is similar to the ASP.NET mode.

d).Windows Card Space (WCS): Windows CardSpace (InfoCard) is a Digital Identity to
online services. Digital Identity is how a user will be electronically represented. Such as
for a debit/credit card, each card has a digital identity and password. If any user uses
the site on internet then he enters their username and password, for identity, but this is
not secure. WCS reduces these types of problems.

iii) .Net Framework 4.0 Features

a).Application Compatibility and Deployment: The .NET Framework 4 is highly
compatible with applications that are built with earlier .NET Framework versions,
except for some changes that were made to improve security, standards compliance,
correctness, reliability, and performance. The .NET Framework 4 does not
automatically use its version of the common language runtime to run applications that
are built with earlier versions of the .NET Framework. To run older applications with
.NET Framework 4, you must compile your application with the target .NET
Framework version specified in the properties for your project in Visual Studio, or you
can specify the supported runtime with the <supportedRuntime> Element in an
application configuration file.

b).Managed Extensibility Framework: The Managed Extensibility Framework (MEF)
is a new library in the .NET Framework 4 that helps you build extensible and
composable applications. MEF enables you to specify points where an application can
be extended, to expose services to offer to other extensible applications and to create
parts for consumption by extensible applications.
It also enables easy discoverability of available parts based on metadata, without the
need to load the assemblies for the parts.
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o).Parallel Computing: The .NET Framework 4 introduces a new programming model
for writing multithreaded and asynchronous code that greatly simplifies the work of
application and library developers. The new model enables developers to write
efficient, fine-grained, and scalable parallel code in a natural idiom without having to
work directly with threads or the thread pool. The new System.Threading.Tasks
namespace and  other related types support this new  model

d).Web : Web Forms, including more integrated support for ASP.NET routing,
enhanced support for Web standards, updated browser support, new features for data
controls, and new features for view state management. Web Forms controls, including
a new Chart control. Dynamic Data, including support for existing Web applications,
support for many-to-many relationships and inheritance, new field templates and
attributes, and enhanced data filtering. Microsoft Ajax, including additional support
for client-based Ajax applications in the Microsoft Ajax Library. Visual Web
Developer, including improved IntelliSense for JScript, new auto-complete snippets for
HTML and ASP.NET markup, and enhanced CSS compatibility.  Deployment,
including new tools for automating typical deployment tasks. Multi-targeting,
including better filtering for features that are not available in the target version of the
.NET Framework

e) Windows Presentation Foundation (WPF) Features in 4.0: Windows Presentation
Foundation (WPF) version 4 contains changes and improvements in such as New
controls, including Calendar, Data Grid, and Date Picker. VisualStateManager
supports changing states of controls. Touch and Manipulation enables you to create
applications that receive input from multiple touches simultaneously on Windows 7.
Graphics and animation supports layout rounding, Pixel Shader version 3.0, cached
composition, and easing functions. Text has improved text rendering and supports
customizing the caret color and selection color in text boxes. Binding is supported on
the Command property of an InputBinding, dynamic objects, and the Text property.
XAML browser applications (XBAPs) support communication with the Web page and
support full-trust deployment. New types in the System.Windows.Shell namespace
enable you to communicate with the Windows 7 taskbar and pass data to the Windows
shell. The WPF and Silverlight Designer in Visual Studio 2010 has various designer
improvements to help create WPF or Silverlight applications.

f).Windows Workflow Foundation Features in 4.0:Windows Workflow Foundation
(WF) provides improvements such as :
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e Improved workflow activity model: The Activity class provides the base
abstraction of workflow behavior.

e Rich composite activity options: Workflows benefit from new flow-control
activities that model traditional flow-control structures, such as Flowchart,
TryCatch, and Switch<T>.

e Expanded built-in activity library: New features of the activity library include
new flow-control activities, activities for manipulating member data, and
activities for controlling transactions.

iv).Net Framework 4.5 Features

a).NET for Windows Store Apps: Windows Store apps are designed for specific form
factors and leverage the power of the Windows operating system. A subset of the NET
Framework 4.5 is available for building Windows Store apps for Windows by using C#
or Visual Basic.

b)Portable Class Libraries: The Portable Class Library project in Visual Studio 2012
enables you to write and build managed assemblies that work on multiple .NET
Framework platforms. Using a Portable Class Library project, you choose the platforms
(such as Windows Phone and .NET for Windows Store apps) to target.

c) ASP.NET: ASP.NET 4.5 includes the following new features:
e Support for new HTML5 form types.

e Support for model binders in Web Forms. These let you bind data controls
directly to data-access methods, and automatically convert user input to and
from .NET Framework data types.

e Support for unobtrusive JavaScript in client-side validation scripts.

e Improved handling of client script through bundling and minification for
improved page performance.

¢ Integrated encoding routines from the AntiXSS library (previously an external
library) to protect from cross-site scripting attacks.

e Support for WebSockets protocol.
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d) Windows Presentation Foundation (WPF) Features in 4.5: In the .NET Framework
4.5, Windows Presentation Foundation (WPF) contains changes and improvements in
the following areas:

e The new Ribbon control, which enables you to implement a ribbon user
interface that hosts a Quick Access Toolbar, Application Menu, and tabs.

e The new INotifyDataErrorInfo interface, which supports synchronous and
asynchronous data validation.

e New features for the VirtualizingPanel and Dispatcher classes.

e Improved performance when displaying large sets of grouped data, and by
accessing collections on non-UlI threads.

e Data binding to static properties, data binding to custom types that implement
the ICustomTypeProvider interface, and retrieval of data binding information
from a binding expression.

e Repositioning of data as the values change (live shaping).
e Ability to check whether the data context for an item container is disconnected.

e Ability to set the amount of time that should elapse between property changes
and data source updates.

e Improved support for implementing weak event patterns. Also, events can now
accept markup extensions.

e)Windows  Communication  Foundation = (WCF) Features in  4.5:
In the .NET Framework 4.5, the following features have been added to make it simpler
to write and maintain Windows Communication Foundation (WCF) applications:

e Simplification of generated configuration files.
e Ability to configure ASP.NET compatibility mode more easily.

e Validation of WCF configuration files by Visual Studio as part of the build
process, so you can detect configuration errors before you run your application.
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New asynchronous streaming support.

e New HTTPS protocol mapping to make it easier to expose an endpoint over
HTTPS with Internet Information Services (IIS).

e Web sockets support to enable true bidirectional communication over ports 80
and 443 with performance characteristics similar to the TCP transport.

e XML Editor tooltips.

f) Windows Workflow Foundation (WF) Features in 4.5: Several new features have
been added to Windows Workflow Foundation (WF) in the .NET Framework 4.5.
These new features include:

e State machine workflows, which were first introduced as part of the .NET
Framework 4.0.1 (.NET Framework 4 Platform Update 1). This update included
several new classes and activities that enabled developers to create state
machine workflows. These classes and activities were updated for the .NET
Framework 4.5 to include:

e The ability to set breakpoints on states.
e The ability to copy and paste transitions in the workflow designer.
e Designer support for shared trigger transition creation.

.NET Framework Architecture

NET is a "Software Platform". It is a language-neutral environment for developing rich
NET experiences and building applications that can easily and securely operate within
it. When developed applications are deployed, those applications will target .NET and
will execute wherever .NET is implemented instead of targeting a particular
Hardware/OS combination. The components that make up the .NET platform are
collectively called the NET Framework. The .NET Framework is a managed, type-safe
environment for developing and executing applications. The .NET Framework
manages all aspects of program execution, like, allocation of memory for the storage of
data and instructions, granting and denying permissions to the application, managing
execution of the application and reallocation of memory for resources that are not
needed.
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Fig Net Framework architecture

The .NET Framework is designed for cross-language compatibility. Cross-language
compatibility means, an application written in Visual Basic .NET may reference a DLL
tile written in C# (C-Sharp). A Visual Basic .NET class might be derived from a C# class
or vice versa. The .NET Framework consists of two main components:

» Common Language Runtime (CLR)
* Class Libraries

i) Common Language Runtime (CLR)

The CLR is also known as the "execution engine" of .NET. It provides the environment
within which the programs run. The main responsibility of the CLR is that manages
the execution of programs and provides core services, such as code compilation,
memory allocation, thread management, and garbage collection. Through the Common
Type System (CTS), it enforces strict type safety, and it ensures that the code is
executed in a safe environment by enforcing code access security. The software version
of .NET is actually the CLR version. When the .NET program is compiled, the output
of the compiler is not an executable file but a file that contains a special type of code
called the Microsoft Intermediate Language (MSIL), which is a low-level set of
instructions understood by the common language run time. This MSIL defines a set of
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portable instructions that are independent of any specific CPU. It's the job of the CLR
to translate this Intermediate code into a executable code when the program is
executed making the program to run in any environment for which the CLR is
implemented. And that's how the NET Framework achieves Portability. This MSIL is
turned into executable code using a JIT (Just in Time) complier. The process goes like
this, when .NET programs are executed, the CLR activates the JIT complier. The JIT
complier converts MSIL into native code on a demand basis as each part of the
program is needed. Thus the program executes as a native code even though it is
compiled into MSIL making the program to run as fast as it would if it is compiled to
native code but achieves the portability benefits of MSIL.

Code in VB IET

- - 3
_ - Eppropriate ]
[ VB HET CDZmp]lEI] [ C# coropiler ] | Corpiler
L
IL{Interrmediate
Language) code

I

CLE. just-in-titne
execution

Fig Common Language Runtime

ii) .Net Framework Class Libraries

Class library is another major entity of the .NET Framework which is designed to
integrate with the common language runtime. This library gives the program access to
runtime environment. The class library consists of lots of prewritten code that all the
applications created in VB .NET and Visual Studio .NET will use. The code for all the
elements like forms, controls and the rest in VB .NET applications actually comes from
the class library.

Name Space
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Net provides several ways to organize the Visual basic code. One among them is
Namespace. A namespace is a collection of different classes. All VB applications are
developed using classes from the .NET System namespace. The namespace with all the
built-in VB functionality is the System namespace. All other namespaces are based on
this System namespace. Some of the namespace in vb.net includes:

1.

10.

11.

12.
13.
14.
15.
16.

17

System: Includes essential classes and base classes for commonly used data
types, events, exceptions and so on

System. Collections: Includes classes and interfaces that define various
collection of objects such as list, queues, hash tables, arrays, etc

System. Data: Includes classes which lets us handle data from data sources
System.Data.OleDb: Includes classes that support the OLEDB .NET provider
System.Data.SqlClient: Includes classes that support the SQL Server .NET
provider

System. Diagnostics: Includes classes that allow to debug our application and to
step through our code

System.Drawing: Provides access to drawing methods

System. Reflection: Includes classes and interfaces that return information about
types, methods and fields

System. Security: Includes classes to support the structure of common language
runtime security system

System. Threading: Includes classes and interfaces to support multithreaded
applications

System. Web: Includes classes and interfaces that support browser-server
communication

System.Web.Services: Includes classes that let us build and use Web Services
System.Windows.Forms: Includes classes for creating Windows based forms
System.XML: Includes classes for XML support

System. Globalization: Includes classes that specify culture-related information
Systemic: Includes classes for data access with Files

. System.Net: Provides interface to protocols used on the internet

Namespace statement can be used to declare a namespace in your own code.
Namespace statements can be nested. For example, a Visual Basic .NET module
could contain these lines of code:

Namespace [Namespace Namel]
Namespace [Namespace Name?2]

—— Public Class [Control Class] —————

Prepared by
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Fig Namespace

By default, a Visual Basic .NET project declares a root namespace that has the same
name as the project. If the programmer needs another name space then import
statement can be used to import the name space. For example Imports system.Data.
The usage of name space will be discussed in the forthcoming chapters to have
better idea about that.

Assemblies

An assembly is another way of organizing code along with namespace. It is a collection
of types and resources that forms a logical unit of functionality. An assembly is the
building block of a .NET application. It is a self describing collection of code, resources,
and metadata (data about data, example, name, size, version of a file is metadata about
that file). An Assembly is a complied and versioned collection of code and metadata
that forms an atomic functional unit. Assemblies take the form of a dynamic link
library (.dll) file or executable program file (.exe) but they differ as they contain the
information found in a type library and the information about everything else needed
to use an application or component. All NET programs are constructed from these
Assemblies.

Assemblies are made of two parts: manifest, contains information about what is
contained within the assembly and modules, internal files of IL code which are ready
to run. When programming, we don't directly deal with assemblies as the CLR and the
.NET framework takes care of that behind the scenes. The assembly file is visible in the
Solution Explorer window of the project

An assembly includes:

» Information for each public class or type used in the assembly — information
includes class or type names, the classes from which an individual class is
derived, etc
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Information on all public methods in each class, like, the method name and
return values (if any)

> Information on every public parameter for each method like the parameter's
name and type

» Information on public enumerations including names and values

> Information on the assembly version (each assembly has a specific version
number)

> Intermediate language code to execute

> A list of types exposed by the assembly and list of other assemblies required by
the assembly

Common Language Specifications (CLS)

If we want the code which we write in a language to be used by programs in other
languages then it should adhere to the Common Language Specification (CLS). The
CLS describes a set of features that different languages have in common. The
CLS defines the minimum standards that .NET language compilers must conform to,
and ensures that any source code compiled by a .NET compiler can interoperate with
the NET Framework. Some reasons why developers are building applications using
the .NET Framework:

o Improved Reliability

o Increased Performance

o Developer Productivity

o Powerful Security

o Integration with existing Systems

o Ease of Deployment

o Mobility Support

o XML Web service Support

o Support for over 20 Programming Languages
o Flexible Data Access

Introduction to Visual Studio — Project Basics and Types
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Visual studio is an editor that is used by programmer to build their application in an
efficient manner. There is always confusion between Visual Studio .NET (VS.NET) and
NET technology. VS.NET is just an editor, provided by Microsoft to help developers
write NET programs easily. VS.NET editor automatically generates lot of code, allow
developers to drag and drop controls to a form, provide short cuts to compile and
build the application etc. Visual Studio is a very user friendly tool. But there is enough
stuff to confuse any one new to Visual Studio family

Projects

VS.NET allows you to create several types of projects. Most of the time you will be
using one of two categories:

1. Windows Application - to create any standard windows application.

2. ASP.NET Web Application - to create a web site.

To create a new project, choose the main menu: File > New > Project. It will give you
several options. First you must select a type from the left side of the popup - you may
choose Visual Basic Projects or Visual C# projects based on the language you plan to
use for development. After selecting a type, you choose a template from the right side.
You may choose Windows Application, ASP.NET Web Application or any other
template based on the nature of the application you want. For building a project, create
a new Windows Project as explained above. It will create a sample form. Go to the
main menu and select the menu item Build > Build Solution. This process will compile
all the files included in your project and show you the result in the Output window. If
the result shows '0 failed’, your build is success and your application is ready to
deliver!! To Run the application you just Built, go to the main menu and select Debug
> Start without Debugging. This will launch the application you just developed You
can drag and drop several controls to the form and try running it. When you compile
(build) the code, if there is any errors or warnings, the details will be shown in the
'Task List' window. You can click on the specific item in this window to go directly to
the line of code associated with the error.
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Fig. Projects in Visual Studio

Integrated Development Environment (IDE)

The Integrated Development Environment (IDE) is the development environment for
all .Net based applications. To say in other words, IDE is shared by all programming
languages in Visual Studio. You can view the toolbars towards the left side of the
image along with the Solution Explorer window towards the right. This section Details
the components of IDE with the screen shots and their usage in developing the
applications.

1 Startup Page

Many of the "global" resources in VS.NET are on the VS.NET Start Page. Many links
are provided from the start up page. They are organized into three categories such as
projects, online resources and profiles. Under the project tab, it is possible to open the
existing projects/application or to create new project/applications. Using the online
resource option, it is possible to link to Microsoft help and reference page. With the
profile option it is possible to change keyboard schemes, windows layout, help filter
and show help settings. Following figure shows the screenshot of startup page.
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Fig Startup page
2 Windows Form Designer

System.Windows .Forms. is the foundation class for all forms to be created. All the
forms that are created in VB .NET are also inheriting from this base class. This class
provides for all the facilities needed for the form. Additional functionality can be

added by separate codes.

3 myFirstProgram - Microsoft Visual Basic 2010 Express

File Edit “ew Project Debug Data Format  Toaols  Window Help

emir=t ™ N N EREE R RS
Pl o ow | k| AL | 2

Farml.vb [Design] >< Qsllss

Properties

Forml System,‘Windows,Forms,Form
[CERY = 1
=B =

=]

AccessibleDescriptior

Accessiblerlame

AccessibleRole
=]

BackColor

Cursar

Fonk
ForeColor
FarmBorderStyle
RightToLeft

Texk

Lleabid sk ey

Text

Fig Windows Form Designer
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3 Solution Explorer Window

The Solution Explorer window gives an overview of the solution we are working with
and lists all the files in the project. An image of the Solution Explorer window is shown
below. It shows the project named as WindowsAppilcation34, an assembly file which
contains assembly information of the application that is discussed in the previous
section and the Form which has the default name Form1.vb. If the programmer adds a
new resource for instance, another Form then the form will be visible in solution
explorer window.

| Solution Explorer - Windowsdpp,., # X |
ER=Nr s
@ Solution "Windowsapplication34' (1 pr
=- Windowsapplication34

5] References

= I®] AssemblyInfo.vhb

b Formi.wb

Fig Solution Explorer Windows
4 Properties Window

The properties window allows us to set properties for various objects at design time.
For example, if you want to change the font, font size, back color, name, text that
appears on a button, textbox etc, you can do that in this window. Below is the image of
properties window. You can view the properties window by selecting View-
>Properties Window from the main menu or by pressing F4 on the keyboard.
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Fig Property Windows

5 Toolbox Window

The toolbox window is the window that gives us access to all controls, components,
etc. As you can see from the image below, the toolbox uses tabs to divide its contents
into categories (Data, Components, Windows Forms and General). The Data tab
displays tools for creating datasets and making data connections, the Windows Forms
tab displays tools for adding controls to forms, the General tab is left empty by default,
the Clipboard Ring tab displays recent items stored in the clipboard and allows us to
select from them.
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Fig Toolbox
6 Intellisense

Intellisense is what that is responsible for the boxes that open as we type the code.
IntelliSense provides a list of options that make language references easily accessible
and helps us to find the information we need. They also complete the typing for us.
The image below displays that.
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Fig Intellisense
7 Server Explorer Window

The Server Explorer window is a tool that provides "drag and drop" feature and helps
us work with databases in an easy graphical environment. For example, if we drag and
drop a database table onto a form, VB .NET automatically creates connection and
command objects that are needed to access that table. The image below displays Server
Explorer window.

ST CESS. S books. mdb . admin
S CESS. Cycurrency . mdb . adomin
A CESS i Sandesepidbl  mndb . admin
+ E sandesep.master.dbo
=B sandesp. MNaortbwind . dbo

&

Zaktegories
Cuskomer_ustomerDierno
—ustomerDemographics
—uskomers
Employess
EmplowesTerritories
Order Dekails
Orders
Producks
F.egion
Shippers
Suppliers

Territories
- [y Wiewws
[=1--- % Stored Procedures
=l [ sandesp.pubs.dbo
Bl G SCOTT

Fig Server Explorer Window
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8 Output Window

The output window as you can see in the image below displays the results of building
and running applications.

Outpuk

Debug

'MMindowsipplication3d': Loaded 'C:ohSandeep VB NETWWindowsippo.
'Mindowsipplication3d. exe': Loaded 'ec:Zwinnthassembly gach sy
'Mindowsipplication3d. exe': Loaded 'c:hZwinnthassemblyhgach sy
'Mindowsapplication3dd. exe': Loaded 'c:Zwinnthassemblyh gach sy
'Mindowsipplicationdd. exe': Loaded 'cowinnthassemblyh gachac
The program '[2160] Windowsipplication3d. exe' has exited witl

1

Fig Windows Form Designer
9 Task List Window

The task list window displays all the tasks that VB .NET assumes we still have to
finish. You can view the task list window by selecting View->Show tasks->All or View-
>Other Windows->Task List from the main menu. The image below shows that. As you
can see from the image, the task list displayed "TextBox1 not declared", "RichTextBox1
not declared". The reason for that message is, there were no controls on the form and
attempts where made to write code for a textbox and a rich textbox. Task list also
displays syntax errors and other errors you normally encounter during coding

=
! Descripkion | File | Lime |
Click here to add a new task
H @ Mame 'TextBox1'is not declared. C:5andeep\VWE.METHY. . .\Forml.vb 67
H @ Mame 'RichTextBox1' is nok declared. C:5andeepi\VWE.METH. . .\Forml.vb 71
Fig Task List Window
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The class view window like the image below is the window that presents solutions and
projects in terms of the classes they contain and the members of these classes. Using
the class view window also helps us to find a member of a class that we want to work
with. As you can notice from the image, the class view window displayed all the
methods and events for the controls which were available on the form.

Class Wiew - Windowsapplication34

=4} Windowsapplication34
EIO[; Farml
EEI---aI; Bases and Interfaces
----- 5% CheckBoxl_CheckedChanged(Object, Eventargs)
----- % DataGrid1_Mavigate(Object, Windaws. Farms. NavigateEventargs)
----- @ Dispose(Boolean)
----- % InitializeCompanent)
s Mesal)
----- 4% Buttoni
----- 4% CheckBoxl
----- o# components
----- 4% DataGrid1
----- 4@ TextBoxl
EEI--@ Windows Application36

Fig Class View Window
11 Code Designer Window

Code Designers like the image below allows us to edit and write code. This is the
window that opens when we double-click on a form or any control. This is the place
where we write all the code for the application. Notice the two drop-down list boxes at
the top of the code window in the image below. The left box allows us to select the
object's code we are working with and the right box allows us to select the part of code
that we want to work. Also notice the "+" and "-" boxes in the code designer. You can
use those boxes to display code Visual Basic .NET already created, like, Windows
Forms Designer generated code, etc.
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F Publie Class Forml
Inherits System.Windows.Forms.Form
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= Private Sub CheckBoxl CheckedChanged (EyWal sender A=z Jystem.Chje
= End Zub

= Private Zub Datacridl Navigate (ByVal sender is System.cbhject, By

- End Sub
“End Class

Fig Class View Window
12 Dynamic Help Window

The dynamic help window displays help which looks up for things automatically. For
example, if you want to get help with a form, select the form and select Help-
>Dynamic Help from the main menu. Doing that displays all the information relating
to forms. The image below displays that. You can get help relating to anything with
this feature. Say, if you want to know more about the form, select the form and select
Dynamic Help from the Help menu. Doing that displays information about the form

13 Command Window

The command window in the image below is a useful window. Using this window we
can add new item to the project, add new project and so on. You can view the
command window by selecting View->Other Windows->Command Window from the

main menu. The command window in the image displays all possible commands with
File.
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File. AddExistingProject
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File, AddhewProject
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Fig Command Window
14 Object Explorer Window

The object explorer window allows us to view all the members of an object at once. It
lists all the objects in our code and gives us access to them. The image below displays
an object explorer window. You can view the object explorer window by selecting
View->Other Windows-> Object Browser from the main menu.

Start Page | Farml.vh [Cesign]*  Object Browser |

Browse: Selected Components - Customize.. 2] - ¥ | i ¥ g
Ohjects Members of 'VECodePravider'
H--O Microsoft Yisual Basic \MET Runtime & || = CreateCompiler()
-+ mscorlib @ CreateGenerator()

1+ System - GetConverter{System, Type)
{} Micrasoft.CSharp @ Mew()
= 4} Micrasaft, visualBasic B! FileExtension
E&g YECodeProvider -
Elag Bases and Inkerfaces
E@l; CodeDomProvider
E|¢Ig Component
E|&[§ MatshalByRefObject
| =] Object
E|°-O IZamponent
\...om IDisposable
() IDisposahle
H-- {} Microsoft. Win3z
t- £} System
i 4} System.CodeDarn
t- 4} System.CodeCam, Campiler
t- {3} Svstem.Callections, Specialized
t- {3} Svsterm.ComponentMaodel
v {3 Svstem.ComponentMaodel, Design
H
]
H
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H
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-} System.ComponentModel, Design, Serialization
-4} System.Configuration
-4} System.Diagnostics
-4} System,I0
4} System. et
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-

Public Overridable ReadOnly Property LanguageOptions As System.CodeDom.Compiler.LanguageC
Member of Microsoft.¥isualBasic. YBCodeProvider

Fig Object Explorer Window
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Creating a simple VB.NET Program

To create your first program, drag the button control into the form, and change
its default Text Buttonl to OK in the properties window, the word OK will
appear on the button in the form, as shown below

¥ Form1

2. Double click the button and open the code window. The code window opens as
shown in the following figure.
3. Type the code as shown below.

4. Msgbox”Welcome to Visual Basic 2010”
5. Compile and Run your program (Press F5 Key)

6. The output for the program is shown below.
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g _[C]x]

WindowsApplication1 E|

‘Welcome to Visual Basic 2010

VB.NET Environment

The Integrated Development Environment (IDE) is the development environment for all Net based
applications. The three steps for planning a Visual Basic application involve setting up the user
interface, defining the properties, and then creating the code The three steps for planning a Visual
Basic application involve setting up the user interface, defining the properties, and then creating the
code

e Design the user interface. When you plan the user interface, you draw a sketch of the
screens the user will see when running your project. On your sketch, show the forms and all
the controls that you plan to use. Indicate the names that you plan to give the form and
each of the objects on the form.

e DPlan the properties. For each object, write down the properties that you plan to set or
change during the design of the form.

e DPlan the Basic code. In this step you plan the procedures that will execute when your
project runs. You will determine which events require action to be taken and then make a
step-by-step plan for those actions.

Event Driven Programming

Visual Basic.Net is event-driven programming. It means that the code will not be
executed until events are triggered (mouse click, button pressing, menu selection,).
Visual Basic.Net is governed by an event processor. Nothing happens until an event is
detected. Once an event is detected, the code corresponding to that event (event
procedure) is executed. Program control is then returned to the event processor.
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@ Event processor

Basic Basic Basic Event
Code Code Code Procedures

Fig Event Driven Concept
All Windows applications are event-driven. For example, nothing happens in Word
until you click on a button, select a menu option, or type some text. Each of these
actions is an event. The event-driven nature of Visual Basic makes it very easy to work
with. As you develop a Visual Basic application, event procedures can be built and
tested individually, saving development time. And, often event procedures are similar
in their coding, allowing re-use (copy and paste).

The Editor Tab and Format Tab

The Editor Tab and Format Specifies the code window and project window settings.

Editor |

Code Settings
¥ Auto Syntax Check [ Auto Indent
[T Require Variable Declaration

Tab Width: | 4
¥ Auto List Members 5%
v Auto Quick Info
v Auto Data Tips

Window Settings

v Drag-and-Drop Text Editing
¥ Default to Full Module View
v Procedure Separator
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e Auto Syntax Check — Determines whether Visual Basic should automatically
verify correct syntax after you enter a line of code.

e Require Variable Declaration — Determines whether explicit variable
declarations are required in modules. Selecting this adds the Option Explicit
statement to general declarations in any new module.

e Auto List Members — Displays a box that displays information that would
logically complete the statement at the current insertion point.

e Auto Quick Info — Displays information about functions and their parameters.

o Auto Data Tips — In the Code window while in Break mode, displays the value
of the variable or object property over which your cursor is placed. The display
is limited to variables and objects that are in the current scope.

Editor Format Tab

Editor Format Tab Specifies the appearance of your Visual Basic code.

Tab Options

Code Colors Determines the foreground and background colors used for the type of
text selected in the list box.

e Text List — Lists the text items that have customizable colors.

e Foreground — Specifies the foreground color for the text selected in the Color
Text List.

e Background — Specifies the background color for text selected in the Color Text
List.

e Indicator — Specifies the margin indicator color.

e Font Specifies the font used for all code.

» Size Specifies the size of the font used for code.

General Tab

Specifies the settings, the error handling, and compile settings for your current Visual
Basic project.
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Form Grid Settings

e Determines the appearance of the form grid at design time.

e Show Grid — Determines whether to show the grid at design time.

e Grid Units — Displays the grid units used for the form. The default is points.

e Width — Determines the width of grid cells on a form (2 to 60 points).

e Height — Determines the height of grid cells on a form (2 to 60 points).

e Align Controls to Grid — Automatically positions the outer edges of controls on
grid lines.

Docking Tab

Allows you to choose which windows you want to be dockable.

Docking

Dockable

v Immediate Window:

[V Locals Window

[V wWatch Window

¥ Project Explorer
[V Properties Window
[T Object Browser
V¥ Eorm Layout

[V Toolbox

[V Color Palette

A window is docked when it is attached or “anchored” to other windows that are
dockable or to the mainwindow when you are in MDI mode. When you move a
dockable window, it “snaps” to the location. A window is not dockable when you can
move it anywhere on the screen and leave it there.
Tab Options
Dockable

e Lists the windows that are dockable.
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Select the windows you want to be dockable and clear those that you do not.
You can have any, none, or all of the windows in the list dockable

Methods and Events

In Visual Basic you will work with objects, which have properties, methods, and

events. Each object is based on a class.

Objects: Think of an object as a thing, or a noun. Examples of objects are forms
and controls. Forms are the windows and dialog boxes you place on the screen;
controls are the components you place inside a form, such as text boxes,
buttons, and list boxes.

Properties: Properties tell something about an object, such as its name, color,
size, location, or how it will behave. You can think of properties as adjectives
that describe objects. When you refer to a property, you first name the object,
add a period, and then name the property. For example, refer to the Text
property of a form called Form1 as Form1.Text (pronounced “form1 dot text”).
Methods: Actions associated with objects are called methods. Methods are the
verbs of object-oriented programming. Some typical methods are Move, Hide,
Show, and Clear. You refer to methods as Object.Method (“object dot method”).
For example, a Show method can apply to different objects. Form1.Show shows
the form object called Forml; btnExit.Show shows the button object called
btnExit.

Events: You can write procedures that execute when a particular event occurs.
An event occurs when the user takes an action, such as clicking a button,
pressing a key, scrolling, or closing a window. Events can also be triggered by
actions of other objects, such as repainting a form or a timer reaching a preset
point.

Classes: A class is a template or blueprint used to create a new object. Classes
contain the definition of all available properties, methods, and events.

Points to Ponder

Programming language acts as an interface between computer and the
programmer

Compute Languages can be broadly divided into three types namely high level
languages, Assembly level languages and Low level languages
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High level languages are so powerful which are widely used by the humans to
communicate with the computer

Visual basic.Net is a good example for High level programming language.

Net framework is a platform or an environment in which the user creates his
applications

NET Framework is a collection of services and classes.

NET Framework is a layer between the operating system and the programming
language.

The .NET Framework consists of two main components namely Common
Language Runtime (CLR) and Class Libraries

The CLR is also known as the "execution engine" of .NET

A namespace is a collection of different classes. All VB applications are
developed using classes from the .NET System namespace

All namespaces are based on System namespace

Assemblies is a collection of types and resources that forms a logical unit of
functionality

The Integrated Development Environment (IDE)is the development
environment for all .Net based applications

The Solution Explorer window gives an overview of the solution we are
working with and lists all the files in the project

The properties window allows us to set properties for various objects at design
time.

The toolbox window is the window that gives us access to all controls and
components

IntelliSense provides a list of options that make language references easily
accessible and helps us to find the information we need
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e The dynamic help window displays help which looks up for things
automatically

Possible Questions
Unit | (8 Marks)

What is .NET? Explain .NET framework.

Write note on Components of .Net Framework.

Explain the different features of .Net.

What is namespace? What are default namespaces available in windows application?
Explain with example: - Class, Property, Methods, and Event.

What is IDE? Explain the IDE in VB.NET.

Explain the different tabs used in VVB.Net

N o g k~ wDnh e
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SUBJECT: . NET Programming

I One Marks
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UNIT-I

.No. Question Option1 Option2 Option 3 Option 4 Answer
1 Net is a technology developed by company Microsoft |Sun IBM Apple Microsoft
2 NGWS Stands for Next Next Next Next Next

3 is also known as the "execution engine" of NET. [CLR CTS MSIL WPF CLR

4 Code that targets the Common Langage Runtime is known as Distributed {[Managed |Legacy |Native |Managed
5 compilers must conform source code compiled by a .NET CLS CTS CLR MSIL  |CLS

6 Which of the following task is done by the Garbage collector?  |Freeing Closing Freeing |Closing |Freeing

7 VB.Net is a programming paradigm. Procedural |Structured |Object Monolith [Object

8 Data members of a class are by default public private static volatile |private

9 Member functions of a class are by default public private static volatile |public

10 IDE stands for Internet Integrated |Internet |Interface |Integrate
11 |The final compiled version of a Projectis Form Software |Compone [Files Compone
12 is a collection of files that can be compiled to createa  [Form Software |Compone |Project [Project
13 is a collection of projects and files that composed an Solution  |Software [Forms Project [Solution
14 Every object has a distinct set of attributes knowns as members |datas properties [methods |propertie
15 The property that must be set first for any new object is the Name Colour Size Binding |Name

16 Objects that can be placed on a form are called Pictures Tools Buttons |Controls |Controls
17 Controls that do not have physical appearance are called invisible-at-|visible-at- |